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Preface 
 
This document provides guidance for using the four North Atlantic Aquatic Connectivity Collaborative (NAACC) Offline 
Data Managers (ODMs) Version 1.8. 
 
The North Atlantic Aquatic Connectivity Collaborative (NAACC) is a network of individuals from universities, conservation 
organizations, and state and federal natural resource and transportation departments focused on improving aquatic 
connectivity across a thirteen-state region, from Maine to Virginia. The NAACC has developed common protocols for 
assessing road-stream crossings (culverts and bridges) and developed a regional database for this field data. The 
information collected will identify high priority bridges and culverts for upgrade and replacement. The NAACC will 
support planning and decision-making by providing information about where restoration projects are likely to bring the 
greatest improvements in aquatic connectivity. 
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Scott Jackson 
Department of Environmental Conservation 
Holdsworth Hall 
University of Massachusetts 
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Fax: (413) 545-4358; Phone (413) 545-4743 
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Overview 
 

What are the NAACC Offline Data Managers? 
The four NAACC Offline Data Managers (ODM) are browser-based computer programs - often referred to as a “web 
applications” - that provide the capability of storing road-stream crossing data in the field whether the user has internet 
access or not.  The data can be easily uploaded to the NAACC website when the internet is available.  The first release 
was on 8/15/2016.  Over 10,000 records have been uploaded using an ODM.   
 
Who should read this guide? 
This guide is for anyone involved in collecting and entering data into the NAACC database using an ODM.  Currently, 
there are four ODMs, the Non-tidal Aquatic Connectivity, the Terrestrial Connectivity, the Tidal Aquatic Connectivity and 
a Culvert Condition ODM.  Coordinators will find useful information and suggestions for planning field surveys, and 
observers will find detailed information on how to navigate to crossings, complete the field forms, and upload collected 
data.  Information technology personnel should read this manual to learn how to set up devices for data collection in the 
field.  We recommend reading the entire guide for your platform before configuring your device, since you may not 
require all the functionality described. 
 

 
Figure 1: The Non-tidal Aquatic Connectivity ODM with the Non-tidal Aquatic Connectivity form and two collapsed Structure 

Data forms. 

1 



 

 

Preparing for Digital Data Collection at Road-Stream Crossings 
 

This section describes some options for prioritizing crossings to survey and navigating to crossings. 
 
Prioritizing crossings for field survey:  
For each state in the NAACC region, United States Geological Survey (USGS) HUC-12 subwatersheds have been prioritized 
for field surveys by the NAACC project team. These subwatersheds were prioritized based on several objectives including 
brook trout, diadromous fish, and the potential vulnerability of culverts to fail, using input from the NAACC workgroup.  
These prioritized results can be a useful starting place for identifying areas to survey.  In addition, there may be locally 
important watersheds or habitats in your state or region that may help guide location of surveys. To see the NAACC 
priority subwatersheds in your area, visit the web map at http://arcg.is/1F2rPJu. This web map also depicts road-stream 
crossings symbolized by their estimated restoration potential, using data from UMass's Critical Linkages program. This 
can help focus survey efforts within a subwatershed.  Finally, for those interested in prioritizing subwatersheds based on 
their own objectives (e.g., only brook trout), an ArcGIS tool is available to allow users to run their own customized 
prioritization using a subset of metrics.  This tool is available for download and use in ArcGIS at  this link. 
 
Navigating to crossings for survey:  
There are several options for navigating to crossings. Windows systems have the advantage of using the open-source, 
free GIS software called “QGIS” for planning and navigating to crossings.  One possible work flow is to go to the NAACC 
search page (https://naacc.org/naacc_search_crossing.cfm) and search for the locations that you plan to survey.  You 
may currently search by state, multiple towns, or by multiple HUC8 watersheds.  The states of NY, PA, VA, and WV have 
too many unassessed crossings to be exported at once, so you are limited to searching by towns or watersheds for those 
states.  Once you have your search results, you may export a shapefile of those results.  You may then open a shapefile or 
shapefiles in QGIS, and clip or merge layers to get the area or areas you wish to survey.  Please note that all shapefiles 
are in the WGS 84, EPSG: 4326 projection.  In addition, you may look at the attribute table for the crossings to survey to 
get information such as the crossing code, town, and watershed.   
 
QGIS can also help for navigating to crossings because the software can import location information from a GPS device in 
real time, which does not require either an internet or cell tower connection.  See the “Using QGIS” section below for 
installation and configuration instructions.  After installing QGIS, the final step is to download a “base” layer map.  Using 
the base layer map, with the shapefile of crossings to survey on top, you will be able to watch your position on the map 
as you travel to each crossing.   
 
First, determine if USGS quadrangle maps are available for your region.  For example, in Massachusetts, seamless USGS 
maps are available for the entire state.  If USGS maps are not available at the state scale, you may download them from 
(http://ngmdb.usgs.gov/maps/topoview/viewer), or use QGIS to download OpenStreetMap data 
(Vector→>OpenStreetMap→Download Data; also see http://www.openstreetmap.org).   
 
There are many other options.  Those without GIS skills may prefer to use the NAACC search page to return search 
results for crossings to be surveyed and then use the “Map results” button to view and print a map.  You may print the 
map by using the “Print Screen” key on your keyboard to copy the screen.  Then an image viewer may be used to paste, 
clip and print the map.  Windows users can use the “Snipping Tool,” and Mac users can use “Grab” to make creating an 
image file from the screen even easier.  Field crews can then use the map and/or a smartphone or automobile GPS 
device to navigate to crossings.  Finally, for those who prefer, data may be collected in the field using paper forms; 
however, the paper method requires entering data both in the field and into web forms on the NAACC website.  The 
paper method thus increases the possibility of transcription errors. 
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Tips: 

• OpenStreetMap: 
◦ OpenStreetMap data is available for entire states in shapefile format (see 

http://download.geofabrik.de/north-america.html). 
◦ QGIS 'Style' files for coloring and formatting OSM shapefile data are available at 

(https://github.com/charleyglynn/OSM-Shapefile-QGIS-stylesheets). 

• Using USGS quadrangle maps: 
◦ For USGS quadrangle maps downloaded from the “topoView” online map, make sure you have “on the fly 

transformation” selected in the project properties, because different years may be in different projections. 
◦ When downloading from USGS quadrangle maps from “topoview,” use the thumbnail view to choose a map 

year with coloring so that you get road and town names superimposed. 
◦ If necessary, you may download multiple maps to get the area coverage you need, but you probably want 

the 1: 24,000 scale. 
◦ If you download multiple maps, you will need to select the correct “Coordinate Reference System” (CRS) 

from the “Layer→ Properties→ General dialog” to tile maps together.  The 'custom' layer will be 
automatically entered for you, but you must explicitly select and save it.  You may open the layer xml file in a 
text editor to find the correct projection and extents to match the custom CRS if necessary. 

◦ To create seamless maps, you may use QGIS to clip borders from the USGS maps.  To accomplish this task, 
you may download the “KMZ” file format from topoView, extract it and use QGIS to create a clipping layer 
(Vector → Research Tools→ Polygon From Layer Extent) from the KML file.  Once you have created the 
clipping layer you may use it to clip each raster layer to create a seamless map (Raster→ Extraction→ 
Clipper).  This may seem like a lot of work, but you will only need to do it once for your coverage area. 
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System Requirements and Installation 
Requirements 
The ODM is a browser-based application that will run on Windows, Android and iOS operating systems.  We require that 
the Chrome browser be used on Windows and Android devices, and that the Safari browser be used on iOS devices.  We 
require these browsers because many browsers do not support the technologies required and because we have limited 
resources for development and testing. Since the ODM v1.8 has been tested on Windows 10, Android 10 and iOS 13.3, 
we require that you upgrade your device to one of these operating systems. Once you have a working ODM, we strongly 
recommend that you do not upgrade your operating system during the 2020 field season.  We have not tested the ODM 
on OS X and would appreciate hearing from users who have tried the ODM on this operating system.  Please note that 
the ODM uses “Responsive Design,” which means that it provides a usable interface on all common devices including 
desktops, laptops, tablets and smartphones. 
 

✓ Please make sure you are running the latest version of Chrome on your device. 
✓ Although most informational messages you receive from the ODM appear in HTML dialogs (which are not pop-

ups), you MUST ENABLE POP-UPS in your browser to see all the important messages that the web application 
may display for you.  Please search for instructions on how to enable popups for your browser.   

✓ Please do not disable pop-ups by checking the “Prevent this page from creating additional dialogs” checkbox that 
may appear in pop-ups.  The ODM will be very difficult to use without being able to view all messages.  

 
Installation 
Installing the ODM is easy: 

1. Log on to the NAACC website at (https://naacc.org/naacc_login_form.cfm) using Chrome or Safari, depending on 
your device’s operating system. 

2. If a new version of any ODM has been released, some ODM files will be automatically updated when you log on, 
and your old ODM will no longer operate, so you must follow the remaining steps. 

3. Click the “Add New Record” link. 
4. Select from the list of radio buttons on the form.  You may choose to manually enter data for any of the four 

assessment modules or update one or more of the ODMs (one after another but not at the same time). 
5. Choose a state by clicking on the image map (which does not appear on iOS) or clicking a state’s link. 
6. If an ODM has never been installed on your device before, a dialog will appear that says, “A new version of the 

offline forms has been downloaded. When you close this dialog, the page will refresh for you to view the 
updated form.”  Please be patient because it can take a few seconds or more for the dialog to appear depending 
on the speed of your hardware.   

7. The dialog will not appear if you have already installed an ODM on your device and you are simply changing the 
state, the logged-on-user or adding an additional ODM. 

8. Once the ODM is installed, look for “Service Worker Registration: successful” and “Service Worker State: 
activated” to know that the download has completed successfully. 

9. Immediately bookmark the ODM page.  This bookmark will open the ODM in your browser whether you are 
online or offline.  There is no need to bookmark the ODM more than once, the same bookmark will work even 
after you update your ODM. 

10. Congratulations! You have completed installing your ODM.  
 
Capturing GPS coordinates on Windows  
If you have a Windows device with built-in GPS or an external GPS device, you may not need to do anything but properly 
configure “Location Services” to allow your browser to access the GPS device.  Please refer to the documentation for the 
GPS device and Windows.  If the ODM does not get coordinates from the built-in or external GPS device when you are 
offline, then you may need to make sure the device is exporting data on a COM port and follow the directions below. 
For Windows users with internal or for external GPS devices that do not capture coordinates after taking the steps in the 
previous paragraph, there are a few more steps if you want to use the “Capture GPS coordinates” button on the Crossing 
Data form (see Figure 3).  
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1) Install the free GpsGate Splitter Express software available at (http://gpsgate.com/products/gpsgate_client). 

2) The splitter will appear in your program menu, but it is configured to start automatically.  It appears in the  

system tray but not your task bar, which is a little unusual for a Windows program.  When you find it in your  

system tray (a red icon that looks like an electrical circuit), right click it and choose “settings.” 

3) Connect your external GPS device to your system and make sure that it is running and providing GPS information. 

4) Click the setup wizard button on the input tab in GpsGate and the program should find your device whether it is 

a USB or Bluetooth device. 

5) Click the output tab and in the “Add output- to where GPS data is sent” drop down choose “GPS in browser” and 

click “Add” to add it to the “Active output-to where GPS data is sent” window. 

6) If your device was discovered, GpsGate will turn green.  Since GpsGate starts automatically, it should  

automatically detect your GPS device whenever you have it connected and turned on. 

7) When online or offline, you can check the “Enable GpsGate” checkbox in the ODM.  Checking the box will  

initialize GPS gate in the browser and you should be able to click “Capture GPS coordinates” in the Crossing Data 

form.  These coordinates should be very accurate depending on your external GPS device. 

8) The latest versions of Chrome seem to have eliminated the following problem.  However, in some cases, Chrome 

may not allow http:// (unsecure) content to be served to an https:// (secure and encrypted) website.  GpsGate 

runs on an http:// connection to your local computer to get the GPS information from your connected GPS 

device, and naacc.org is an encrypted and secure website.  When you first click the “Capture GPS coordinates” 

button, a small gray shield might appear in the Chrome address bar.  You must click the shield and click the link 

that says, “load unsafe scripts.”  After you click the link, you must reselect the checkbox for GpsGate and click 

“Capture GPS coordinates” again.  The coordinates will appear, and that will enable GpsGate for your entire 

session.  There is absolutely no security risk because the unencrypted http connection originates from your own 

computer. 

 

Using QGIS  
In the “Preparing for Digital Data Collection” section above, we described how to use QGIS to navigate to crossing 

locations.  To download QGIS go to (https://www.qgis.org/en/site/forusers/download.html) and follow the installation 

instructions. 

 

If you want to use QGIS and capture GPS coordinates in the ODM at the same time, you need to do a little more 

configuration.  Starting at step (5) in the instructions above for configuring GpsGate, in the “Add output- to where GPS 

data is sent” drop down, choose “Virtual COM Port” and click the “Add” button to add it to your “Active output-to where 

GPS data is sent” window.  It doesn’t really matter which COM Port number you choose but take note of it for 

configuring GPS in QGIS. 

 

Open QGIS and go to View → Panels and check “GPS Information Panel.”  This action will make a tab available in the 

“layers” panel named “GPS Information Panel.” With your GPS device on, connected to your tablet using GpsGate, and 

the GPS Information panel selected, you can click the button with the wrench icon and then click the “Serial device” 

radio button.  In the drop-down menu, choose the serial port number that you added to GpsGate, and then click the 

“Connect” button.  A resizable circle with crosshairs should appear on your map, assuming you are at a location that 

appears on the map you are viewing.  This function has been fully tested on the Windows platform using GpsGate as the 

“middleman” between your external GPS device and QGIS.   
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Instructions for Using the ODM 

 

 

The ODM consists of three sections (Figure 1): (1) the “Non-tidal Aquatic Connectivity Offline Data Manager” section 

(Figure 2), (2) the “Non-tidal Aquatic Connectivity Form” section, and (Figure 3) (3) the “Structure Data” forms section.  

The instructions below describe how to use each of these sections. 

 
Using the Offline Data Manager section: 
(The section below describes the Aquatic ODM, but the using the Terrestrial, Tidal and Culvert ODMs is nearly identical.) 
 
Status: The status label can display “Online” or “Offline.”  The web application checks network status about every 10 
seconds because the user interface changes depending whether you are online or offline.  When online, the “Save to 
Server” button (see Figure 2) and the “View Map” button (see Figure 3) appear.  When offline they are not usable, and 
thus are hidden. You should disable internet access when you are in the field to avoid potential problems that could arise 
due to intermittent or weak internet connectivity.  
 
Enable GpsGate: This checkbox is only used by those running Windows with GpsGate, as described in the “Capturing GPS 
coordinates on Windows” section above.  It is not visible on other platforms. 
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Figure 2: The Offline Data Manager section of the Non-tidal Aquatic ODM displayed in the Chrome web browser. 



 

 

Check Storage Space: On all devices, there is a “Check Storage Space” button to the right of the “Status” label.  On 

Windows and Android devices, clicking this button will show the percentage of available space that has been used by the 

ODMs.  On iOS, clicking the button will show a message indicating that iOS does not support displaying how much 

storage has been used.  You may go to Settings-> Safari->Advanced->naacc.org to get an indication of how much data 

your ODMs are using; however, we have no idea how Apple calculates this number or how accurate it is.  Apple limits the 

size of the browser database to 50 MB on iOS devices, which can be 7 to 15 records, depending mainly on how many 

photos are stored for each record.  If you exceed the limit, information you enter for crossing records will not be written 

to the database, and you will not be warned.  iOS users should check storage space frequently.  Please contact Bob 

English (bobengl@gmail.com) for assistance if you find you need to store more records on iOS.  If you are using Windows 

or Android, the number of records you can store is limited to 50% of the capacity of your hard drive  

(https://developer.mozilla.org/en-US/docs/Web/API/IndexedDB_API/Browser_storage_limits_and_eviction_criteria).   

 

Service Worker Registration and Service Worker State: “Service Workers” has been supported on iOS since version 11.4  

on Windows, Android, and iOS, there are several values for these two items.  If the “Service Worker Registration” is 

“successful” and the “Service Worker State” is “activated,” then the ODM is working properly.  If these two items have 

any other value, then you should try to download your ODM again.  If the problem persists then report the problem by 

emailing contact@naacc.org. 

 

Saved offline crossing records: This table shows all crossing records that have been saved in the ODM, whether they are 

complete or incomplete.  Looking at the “Saved offline crossing records” table in Figure 2 above, the “Name” column 

contains the “Crossing Record Title” entered in the “Add offline crossing record:” text input when the crossing was 

created.  The “On device” column contains a link that will display the crossing in the ODM when clicked.  A dialog will 

appear, saying, “Your record has been opened.”  The “Survey ID” column will say “Not submitted” until you are online 

and have submitted the crossing record to the NAACC website server.  Once the record has been successfully submitted, 

the Survey ID number of the submitted record will appear as a link.  If you are online and click the Survey ID link, a new 

window will open displaying the crossing record as it exists in the NAACC website database.  The “Delete Crossing” 

column contains a link that will delete the record from your device.  If the record has been submitted, the record on the 

NAACC website will not be affected by deleting your local copy. 

 

Add offline crossing record: Entering a “Crossing Record Title” should be the first thing you do when entering a new 

crossing record.  When you tab out of the text input, the new crossing will dynamically appear in the “Saved offline 

crossing records” table.  If you forget to enter a crossing title, you will be reminded to do so when you try to enter data in 

the “Crossing Data” section.   

 

Photos: You need to choose a radio button for the photo you are taking (e.g., inlet, Outlet, Upstream).  After adding a 

photo, you will see a dialog that informs you that “Your photo has been saved” to the browser’s database.  There are 

three ways to add photos to your record. 

• If you are using a non-iOS device, you will see a “Show/Hide Camera” button.  Clicking this button will 

toggle a “canvas” to open or close.  Within the canvas, you will see a movie of what your device camera is seeing, 

and you will see a “Take photo” button allowing you to capture a still image that will appear in one of the image 

boxes below the canvas.  If your device has more than one camera, the “environment” view (meaning facing 

away from you) should show.  If the camera is showing the wrong view (facing towards you), you can turn the 

device away from you to take the photo or use one of the following two options.  

• You can use the “Choose File” button to open a dialog.  On iPads and many other devices, you will get a 

dialog allowing you to take a picture with your camera. After taking the picture, it will appear in the image box in 

the ODM. 
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• You can take your pictures and save them on your device.  You can then use the “Choose File” button to 

browse to the files and import them into the ODM. 

Save to Device: This button appears in all the sections of the ODM, including all Structure Data forms.  Clicking this 

button will save all the photos and data in your record to the database in your device and inform you that the data have 

been saved.  Please use this button often to avoid losing data. 

 

Validate form(s) offline: This button appears in the “Offline Data Manager” section and at the bottom of every 

“Structure Data” form.  When clicked, it will check all your forms using the same data entry validation rules that are 

applied when entering data manually on the NAACC website.  A dialog will inform you of results.  By using this system 

before uploading your record, you can be certain that the record will be accepted and written to the NAACC database. 

 

Tip: When entering crossing data, you may want to choose the “Crossing type:” and then click the “Validate form(s) 

offline” button.  You will see messages in red text (see Figure 3) that inform you which inputs are required for that 

crossing type.  The messages will disappear as you enter the information correctly.  You may do the same for each 

Structure Data form you need to complete. 

 

Save to Server:  This button will only appear when you are online.  When you click the “Save to Server” button, the web 

application checks to see if you are logged on.  If you are not, the login form will appear in a separate window.  The 

application will then validate all form data and prompt you to choose a crossing code (if you have not done so) by clicking 

the “View Map” button.  If all your form data validates, the entire record, including images and structures, will be 

uploaded to the NAACC database.  You will immediately be able to view the record on the NAACC website by clicking on 

the Survey ID link.   
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Using the Aquatic Connectivity Crossing Data form section 
 

Coordinator and Lead Observer: The coordinators and lead observers displayed in the two drop-down menus depend on 

the user who logged on and installed the ODM.  If you are an L2 coordinator and you logged on to download the ODM, 

you will see yourself and all your “child” (L1) coordinators in the “Coordinator” drop down menu, and you will see all 

your lead observers and the lead observers of all your “child” coordinators in the “Lead Observer” drop down.  If you are 

an L1 coordinator, then you will see only your name in the “Coordinator” drop down menu, and you will see all your 

“child” observers in the “Lead Observer” drop down.  If you are a lead observer, you will see only your coordinator’s 

name in the “Coordinator” drop down, and only your name in the “Lead Observer” drop down.  As of version 1.6, you 

will only be able to open records that were created in an ODM that was updated when you were logged on.  This feature 

prevents users from creating records using coordinators and observers who are not their children, and thus prevents 

incorrect data from being entered into the database. 

 

Town: The “Town” drop down menu will contain all the towns or counties that cover the entire area of the state you 

selected when installing the ODM. 
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Figure 3: Non-tidal Aquatic Connectivity Crossing Data form and Structure Data forms sections of the ODM. 



 

 

Capture GPS coordinates: When you click the “Capture GPS coordinates” button, coordinates will be automatically 

inserted into the Lat and Long text inputs.  You should be careful to check that the coordinates for your location are 

accurate when using the “Capture GPS coordinates” button.  When you click the button, there are several possible 

sources for information about your location.   

1. If you are online and you do not have an internal or external GPS device sending GPS information, you will get 

coordinates from the “Location Services” provided by Google or Apple.  The accuracy of the coordinates 

provided by location services vary widely from very accurate to inaccurate by fifty miles or more.  To avoid using 

“Location Services,” you should make certain that an internal or external GPS device is working on your device.  If 

you are online, you can use the “View Map” button to check the GPS coordinates for accuracy or view the GPS 

coordinates directly on your GPS device or on an “app” that shows coordinates for internal GPS devices. 

2. If you are online or offline and using an Windows device with a built-in internal GPS device, or an iPad, iPhone, or 

Android device, the location will be provided by the GPS application built into the device, and the accuracy will 

vary but can be quite accurate.  If you are using a GPS application, the coordinates will usually be provided by the 

application, which seems to increase the accuracy substantially. 

3. If you have a Windows tablet or another device connected to an external GPS device, the coordinates should be 

very accurate. 

You should be aware that the coordinates provided by your device may be “cached” coordinates collected at some time 

in the past.  This can happen if the internal GPS device can’t “see” satellites or if your external GPS device has 

disconnected. 

 

We have tried to provide dialogs with warnings and information about the status of GPS information when you click the 

“Capture GPS coordinates” button, but this information is not perfect.  Using this button can be very convenient and 

provide very accurate location information, but you must be alert and informed to use this system to your advantage. 

 

View map:  The “View map” button will only appear when you are online because the map needs an internet connection 

to get the map information from Google Maps.  Many users will be quite familiar with using the “View map” button from 

training and/or entering crossing records manually.  When you click the button, a map will appear with a red star 

indicating the location of the GPS coordinates you have entered along with all the surveyed and unassessed crossings 

within 500 feet of your GPS coordinates.  You can drag and drop your “red star” to existing surveyed or unassessed 

crossings, or you can create a new crossing location to add a “Crossing code” to your record.  The purpose of this system 

is to accurately identify the location that you surveyed.  Please note that you may need to zoom in very far to 

successfully select a crossing code. 

 

Number of Culverts/Bridge Cells: When you enter an integer between 0 and 9 into this text input, the web application 

creates that number of Structure Data forms at the bottom of the ODM.  If you change the number, the ODM will add or 

delete Structure Data forms.  A confirm dialog will appear to prevent accidentally deleting structure data. 

 

Using the Structure Data form section 

 

The Accordion: 

The Structure Data forms appear in an “accordion.”  If there are multiple forms, just click on the arrow on the left to view 

a form.  To make scrolling easier, open forms will be automatically closed when you open a different form. 
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Show All to Save PDF: When this button is clicked, all the Structure Data forms are expanded so that all the data is visible 
and can be saved to a PDF backup, but clicking this button does not automatically save the record as a PDF.  Saving as a 
PDF works on all the devices we tested.  You can search the web or your device documentation to learn how.  The PDF 
that you save cannot be uploaded to the NAACC server, but you can use the PDF to enter data and photos manually 
through the NAACC website forms.   
 
To avoid losing data, it is very important that you make a PDF backup of each record in the field after you have finished 
entering the data and the data has passed data entry validation.  You should make a PDF backup of every record, and you 
should back up your device to a secure location after each day of field work.  We also recommend that you upload your 
crossing records to the NAACC database as soon as possible after collecting them. 
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Final Reminders and Cautions 
 

The ODM is based on World Wide Web Consortium (W3C) standards (https://www.w3.org/Consortium/) and web 
browser technologies that are relatively new and evolving.  Because they are based open web standards, the 
technologies used in web applications such as the ODM should continue to improve over time. That said, during beta 
testing we discovered some issues and some actions that you should take to avoid losing data. 

 

• On Windows, the database is stored in the logged-on user’s folder.  If you open your ODM and don’t see your 
records, please make sure you are logged on as the user who created the records. 
 

• Do not clear your browser cache while you have records stored in your ODM.  Depending on your device and 
browser, you will likely delete the ODM and your records from your system.  If you need to clear your cache, 
make sure you have uploaded all your records, and be aware that you may need to “update” your ODM on the 
NAACC website. 
 

• You should give the ODM a second or two to save data before you exit your browser or shut down your 
computer.  Messages displayed in the ODM about your data being saved do not necessarily mean that the data 
has finished being written to your disk drive, although that is usually the case. 

 

• Please do not have more than one ODM window open at a time.  This is a known limit of the technology used for 
the ODM and can cause database inconsistencies and data loss. 
  

• Please be careful not to allow your device to run out of power and shut down.  This could leave the database in a 
corrupted condition and possibly lead to the database and/or the ODM being deleted.  In this case, you would 
lose any records stored in the ODM. 

 

• Also, make sure that you have an excess of storage capacity on your device (at least 10 GB).  The browser may 
delete the built-in database if the operating system is running out of storage space.  If this happens, you would 
lose any records stored in the ODM. 

 

• Be careful when storing records iOS devices because they will save incomplete records without warning when 
the 50 MB database size limit is reached.   

 

• After reading the above, you will understand why it is very important to back up your crossing record data.  In  
the field, please save each crossing record as a PDF on your device as soon as you have finished entering the data 
and the data have passed data entry validation. If necessary, you can use the PDF backup to manually enter your 
record, including photos, through the NAACC website.  It is also a good idea to back up your PDF files to a flash 
drive during the day in case your device is dropped or submersed in water. 
 

• If you cannot upload your records to the NAACC server at the end of a day in the field, please back up your 
device so that you do not lose your ODM records and PDF backups. 
 

• We recommend that you upload your crossing records to the NAACC server as soon as possible after you have 
surveyed the crossings. 
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